MATIAB and SIMULINK
Tutorial for ELG3311

TAS
Peng He and Saeed Salehi



What is MATILAB?

It stands for MATrix LABoratory

It is developed by The Mathworks, Inc.
o (http://www.mathworks.com)

It is an interactive, integrated, environment

o for numerical computations

o for symbolic computations

o for scientific visualizations

It is a high-level programming language

o Program (or script, actually) runs in interpreted, as opposed
to compiled, mode

Many application-specific toolboxes (functions)
available
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Strengths of MATLLAB

MATLAB is relatively easy to learn

MATLAB code Is optimized to be relatively
guick when performing matrix operations

MATLAB may behave like a calculator or as a
programming language

MATLAB Is interpreted, errors are easier to
fix

Although primarily procedural, MATLAB does
have some object-oriented elements
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Weaknesses of MATLLAB

MATLAB is NOT a general purpose
programming language

MATLAB is an interpreted language (making
it for the most part slower than a compiled
language such as C++)

MATLAB Is designed for scientific
computation and is not suitable for some
things (such as parsing text)
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The MathWorks Product Family
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Filter Design
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Statistics
Optimization
Image Processing
Others...
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Starting MATLAB

= When starting up the
MATLAB program, MATLAB

MATLAB loads, checks that | =
a license Is available and

throws up a splash screen.

‘k The MathWorks

1 File Edit Debug Desktop Window Help

. eX S eS O D@| b mE@ o o[ 8rf B %] curembirectory | flocahomejre /| |
Shortcuts [#] How to Add  [Z] What's New
Current Directory - /localhome/re EREE| command Window
‘j@‘av <HATLAB >

Copyright 1984-2006 The MathWorks, Inc
o ST [Fie Type [siee version 7.2.0.294 (R20063)
n |3 adobe Folder Janwary 27, 2006

[ config Folder
02 .dia Folder To get started, select WATLAB Help or Dewos from the Help menu
I3 eclipse Folder s
I3 eqacups Folder =
I3 evolution Folder
I3 geonf Folder
1 .gconfd Folder

Current Directory| Workspace

Command History A x
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. MATLAB Desktop
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MATLAB Desktop

Use tob to go to Current
Directory browser.

-} MATLAB

dit “iew ‘Web indow \ Help

GetYelp.

Enter

MATLAB

functions.

Viewor chonge
wrrent
directory.

Click to move window  Close window.
outside of desktop.

| ﬁ‘ Stad(:IElase Tl

Nane \

|Size

Bytesl Clas

Jl

| 2

51 L2 Workspace I Current Directory I

Curnrmand Windows

=

0 get started, select "MATLAE Help™ from the Help mernu.

Carmmand History
$-— 8/12/02 B:52 AM —-% =
—
4 | »H B
4\ start | N\ \
Expund&u View View or use previously run functions. Drog the seporgtor bar to resize windows.

dotumentotion, demos, ond
tools for your produes.
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MATLAB Desktop: Command Window

Use the command
window to ”

and run
functions and M-files.

o For example:
a=2.5;
b = ones(5,5);
.
Command History e £t Viow Weh Winiow b

o Bz 0z oo aM = || Timestomp murks the

] stort of eoch session.
which collatz

o Statements you enter in

collatzplot(d)

Select one or more lines
. dbquit " und right-tlick to copy,
the Command window are Jous tnea evlunte, o et

. n{l7] M-file from the selection.
logged in the Command

ode23('lotka' [0 2],[20:20])

[t,¥] = ode23{'lotka',[0 2],[10:101}
H IStO ry collatz(5)

-

To get started, select "MATLAE Help™ from the Help menu.

v
1

— .
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MATLAB Desktop: Workspace Browser

The MATLAB workspace consists
of the set of variables (named

--,_!- Workspace M=l

arrays) built up during a MATLAB e
session and stored in memory. 5 | oy

. Double-click EEE 4 double array
You add variables to the ocwete {5 N DR ST
workspace by using functions, gwho | B P00 doulearay Gioka)
running M-files and loading saved  g." @ Mo 0 doubleamay Gegd
workspaces. S I R

. HE ¥ struct arra
To delete variables from the i SO R Wi
workspace, select the variable and

select Delete from the Edit menu.
Alternatively, use the “clear”
function.
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Scripts and Functions: M-file

Sequences of MATLAB commands can be written to files
with the extension .m, appropriately called M-files.

Entering the name of the file (without the extension!)
causes automatic execution of all the statements. In their
simplest form, such files are called script files.

Script files do not take the input arguments or return the
output arguments.

The function files may take input arguments or return
output arguments.
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An Example of Script Files

Create a file by the name, say, mytest.m.

Contents of mytest.m:

9/18/2006

Xx=45*pi/180; % convert degrees to radians

a=sin(x); % compute sine 45 degrees

b=cos(x); % compute cosine 45 degrees
disp(‘sin(45*pi/180)") % print header disp(a) % print result

ELG3311: Electric Machines and Power Systems
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‘ An Example of Function Files

function vy = cosgen (x,a, f,p)

a2 o\ o\@ ol g\ o\l

O

COSGEN CGeneration of a cosine wave

cosgen (x,a, f,p)
cosine of x
amplitude
frequency [hertz]
phase [radiang]

y = a*cos( 2%p1*f*(x + p/(2%pi*1)) ).

9/18/2006
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Matlab also has many built-in functions

>> abs(X) % absolute value of x

>> exp(X) % e to the x-th power

>> fix(X) % rounds x to integer towards O

>>logl0(x) % common logarithm of x to the base 10
>>rem(Xx,y) % remainder of x/y

>> sqrt(x) % square root of x

>> sin(x) % sine of x; X in radians

>> acoth(x) % inversion hyperbolic cotangent of x

>> help elfun % get a list of all available elementary functions

>> sgrt(c4) >> e = ones|(3,3)

ans

0o

>> sin(pi/2)
ans = 1

>> abs (—5¢6)
an=s = L&
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Editing M-file through Editor Window

o Use the Editor/Debugger to create and debug M-files,
which are programs you write to run MATLAB functions.

o The Editor/Debugger provides a GUI for basic text editing,
as well as for M-file debugging

Create a new M-file: File > New - M-file
Open an M-file: File - Open

_Ii x|

File Edit Mew Text Debug Breakpoinks Web Window Help
DSEE| 2R o fh| 88 3 x
1 x=1:5; Ll

2 = 3%N+E;

g b

Ready
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Rules on Variable and Function Names

Variable/Function name
o begins with a LETTER, e.g., A2z.

o can be a mix of letters, digits, and underscores (e.g., vector_A, but not
vector-A (since "-" is a reserved char).

o Is case sensitive, e.g., NAME, Name, name are 3 distinct variables.
o must not be longer than 31 characters.

o Suggestion:

Since MATLAB distinguishes one function from the next by their file names, name
files the same as function names to avoid confusion.

Use only lowercase letter to be consistent with MATLAB's convention.
File name

o Files that contain MATLAB commands should be named with a suffix of ".m",
e.g., something.m.

o These include, but not restricted to, script m-files and function m-files.
o Note: To use it, just refer to it by name, without the suffix, e.g.,
o >>something
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‘ Operatots

Arithmetic Operators Relational Operators

O perator | Description

— Operator | Description
+ Addition
- Subtraction = Less than
L Multiplication == Less than or equal to
Right division = Greater than
Left division == Greater than or equal to
+ Lnary plus —— Equal to
— e ———— = Mot equal to

Colon aoperatar

S Fower .
K S ———— Logical Operators
. Complex conjugate transpose .
Operator | Description

* Matrix multiplication

. o & END
& Matrix right division
\ Matrix left division | CR
-~ Matrix power = HOT
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Hints for Editing and Run a M-file

Hints
o “%”is for comments.

o “” delimits statements; suppresses screen output
o “” create lists with fixed step
o “..” statement continuation, e.g.,
> x=[135 ...
7 9]; W x=1]J1357 9] splitted into 2 lines
o “”--command delimiter, e.g.,
>> x = [1:2:9], v = [1:9] % two statements on the same line
o Define some variables:
o X =1:5; y= 3*x+1;
o “clear all; close all;” at the top-line of .m file
o Use MATLAB functions and programming language.
Run the M-file: (if the M-file is under the current directory)
o In the command window, input the name of the M-file and then ENTER.
o In the editor window, press F5.
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How to find help in MATLAB?

“On-line” help i oo

o To find out about the syntax for
any of the commands you can
type
>>help <commandname >
inside of MATLAB.

Help browser

o Use the Help browser to search
and view documentation and e £ Yor 0 b i\ = =

4= = (5 & | Fndinpage: Go
demos for aII your MathWOrkS \ P’”“““”'"E"FA”GSE‘E“E" /MATLAEIRE\E@SEH / j Add to Favorites

ortorts | naex | search | pemos | Favortes | -
products. B oo s j
. €3 Installation
o To open the Help browser, click

Tabs in the Help Navigator pune provide different woys to find documentation und demos. View documentation in the disploy pune.

Use the elose box to hide the pane. Drag the separator hor to adjust the width of the punes.

[ What's New

KECU
@ CDMa Reference Blockset 3

9/18/2006

the help button in the toolbar, %

or type “helpbrowser” in the
Command Window.

@ support and Web Services

y
+ Demos - Now run demos for MATLAB and other products
from the Demos tab in the Help browser.
+ Release Notes describe new features, new products, and
impartant bug fixes

[¥ Product Documentation and Demos
+ MATLAB Documentation provides complete infarmation

about using MATLAB. hd
1] | »

ELG3311: Electric Machines and Power Systems

20



#

File Edit View Go Web Window Help

Help Mavigator

Product fitter: ** Al Selected Select...

Contents | Index  Search Favorites

—@ Begin Here
- R12 Release Notes

E]—g;rv1ATLAB
—[f Getting Started

[ Introduction

E]—@ Development Environment
[]—@ Manipulating Matrices

E]—@ Graphics

[]—@ Programming with MATLAB
= Using MATLAB

[]—@ Development Environment
= Mathematics

Programming and Data Types
@ M-File Programming

ﬁ Character Arrays (Strings)
@ Multidimensional Arrays
ﬁ Structures and Cell Arrays
@ Function Handles

ﬁ MATLAE Classes and Obje
]—@ Graphics

[l 3-D Visualization

]—@ Creating Graphical User Interfz
[l External Interfaces/AP|

—@ Index of Examples

[]—@ Reference

—@ Printable Documentation (FDF)
[ Froduct Page (Weh)

[+ Simulink

- Stateflow

dq 2

Ready

4/ & & Findin page:

Programming and Data Types: M-File Programming

Programming and Data Types

M-File Programming

Go

2

066

Add to Favarites

€

MATLAB provides a full programming language that enables you to write a series of MATLAB
statements into a file and then execute them with a single command. You write your program in
an ordinary text file, giving the file a name of £ileneme.m The term you use for £ilename
becomes the new command that MATLAB associates with the program. The file extension of m

makes this a MATLAB M-file.

This chapter explains the basics of how to write script and function programs in M-files. It covers

the following topics:

MATLAB Programming: A Quick Start
cripts

Functions

Local and Glabal Variables

Data Types

Operatars

Flow Control

Subfunctions

Private Functions

Subscripting and Indexing

String Evaluation

CommandiFunction Duality

Empty Matrices

Errors and Warnings

Dates and Times

Obtaining User Input

# Zhell Escape Functions

L]

LK BB B B B B BE N BE R R R B K B
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Il. MATLAB BASICS

9/18/2006
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Introduction to Vectors in Matlab

MATLAB is designed to work with matrices, but you can
also input scalars and vectors since they can be
considered as matrices with dimension 1x1 (scalars) and
1xn or nx1 (vectors).

Defining a vector

Accessing elements within a vector
Basic operations on vectors

Go to link:

o http://www.cyclismo.org/tutorial/matlab/vector.html
o http://www.cyclismo.org/tutorial/matlab/operations.html
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Introduction to Matrices in Matlab

Defining Matrices
Matrix Functions
Matrix Operations

Go to link
o http://www.cyclismo.org/tutorial/matlab/matrix.html

The colon operator

1:10 is a row vector containing the integers from 1t0 10: 123456789 10
To obtain nonunit spacing, specify an increment.

For example, 100:-7:50 is 100 93 86 79 72 65 58 51

Subscript expressions involving colons refer to portions of a matrix.

A(1:k,j) is the first k elements of the jth column of A.

o A(,)) is the jth column of A.

o A(,:) is the ith row of the A.

o U 0O O

()

9/18/2006 ELG3311: Electric Machines and Power Systems
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Plotting

MATLAB supports a number of plot types with the ability
to create custom graphs.

The simplest x-y type plot can be created using plot(x,y)
where x and y are vectors with a list of values stored in
them.

Other plot commands including:

o loglog, semilogx, semilogy, bar, stem, polar, plot3, contour,
mesh and surf.

To find out about the syntax for any of the plot
commands you can type help <commandname > inside
of MATLAB.

The figure plotted will be shown in the Figure Window.
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Plotting (2)

Example 1: Using the colon to create lists and
generating a plot

Q

9/18/2006

>>x=[1:.5:10]

Defines a vector x that goes from 1 to 10 by 0.5. The
colon is used to both create a list using the syntax
[lower:increment:upper] and to select specific portions
of a matrix.

>> y=2*X
Defines a vector y with values equal to twice the
values In X.

>>plot(X,y)
Creates a simple x-y plot of the data stored in the
vectors x and y.
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Plotting (3)

Adding text, setting scales and styles
o >> axis([xmin xmax ymin ymax])

Sets the x and y scales to the values you specify
o >> title("title text®)

Places a title above the plot. The commands
xlabel('xtitle text') and ylabel('ytitle text') place a titles
along the x and y- axes, respectively.

o >>text(X,y, "your text")
Places any text string at the graph coordinates (X, V)

9/18/2006 ELG3311: Electric Machines and Power Systems
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Plotting (4)

Styles including color and line type can be specified by using a 2 or
3 character string inside the plot command immediately following the
y variable. For example, the command plot(x,y, "r—--") will
produce a red dashed line. The available color and line type
variables are given below:

o For color:y yellow;m magenta;c cyan;r red;g green;b blue;w
white;b black

o For line type: .point;o circle;x x-mark;+ plus;* star; - solid;:
dotted;- . dashdot;-- dashed

Plotting more than one data set on an a single axis can be

accomplished by using the command hold on and then plotting the
additional data followed by a hold off command.
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Plotting (5)
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Plotting (0)

Example2: simple plots

The following sequence of commands plots the graph of the
sine function between 0 and &, provided that the two arrays

have the same number of elements.
>> xX = 0:p1/90: pi;

>> yy = sin(xx);

>> plot(xx, yy)

>> grid on

>> xlabel (“xx, radians?)
>> ylabel (“sin(xx)?)

Example3: subplot
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Data

10

This is an example

/
e
/
# | =
/ |
/}D
ook at this ! i

/

time ®¥, radians
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‘ MATLAB Programming

= Loops
o For Loops
2 While Loops

o Go to link:
m  http://www.cyclismo.org/tutorial/matlab/control.html

w |f
o Go to link:
s http://www.cyclismo.org/tutorial/matlab/if. html
= Subroutines (optional)

o Go to link:
m  http://www.cyclismo.org/tutorial/matlab/subroutine.html

9/18/2006 ELG3311: Electric Machines and Power Systems
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What 1s SIMULINK?

SIMULINK 1Is an extension to MATLAB which uses
a icon-driven interface for the construction of a block
diagram representation of a process.

Simulink encourages you to try things out.

A block diagram is simply a graphical representation
of a process (which is composed of an input, the
system, and an output).

inpuis » Syst_em P OUIPULS

Figure 1: A YVERY eimple block diagram of a process.
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About SIMULINK

SIMULINK uses a graphical user interface (GUI) for
solving process simulations.

Instead of writing MATLAB code, we simply connect
the necessary ‘icons" together so as to construct
the block diagram.

The “icons" represent possible inputs to the system,
parts of the systems, or outputs of the system.

SIMULINK allows the user to easily simulate
systems of linear and nonlinear ordinary differential
equations.
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Starting SIMULINK

= To start Simulink, on
File Edit Wiew ‘Web Window
the MATLAB Command O @ | rentDirec:tDry:lm
prompt, type TR
-— - File Type Last Modifiec
B >>S I mu I I nk Folder 25-0ct-2003 04
IrigoyenOl Folder 25-0ctc-2003 0
‘DTDTDJ_ Folder 25-0ct-2003 0
4314dem|:|.m M-file OS-Jun-1999 0
4343—1&1{.111 M-file O05-Jun-1%99 0
O hrusselatur.m H-file 30-Mar-=003 0
- r Dchausl.asv AZW File 09-hug-2003 0
chaosl.m M-file 09-iug-2003 0
Dchausz.asv ASYV File 09-hug-2003 0
chau:usz.m M-file O9-hug-2003 0
. dampﬂy.m M-file 24-May-2003 0 =
= Click here P S— :
_'Ef_‘-.fﬂnrkspace Current Directory I
Command History
marogin ) -~
margin(—q)
Goor=-10%loglid{alpha)
Gc -
<\ Start
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“Simulink Library Browser” will open.

(1 Simulink Library Browser
File Edit Wiew Help

O = 4= da |

Integrator: Continuouz-tinne integration of the input zignal.

=1 Wl sirnulink
: ! Zommonly Used Blocks

[+

dusdt O =rivative

Continuous

W)=

Clicconkinuities Integratar

Discreke

X = Pz+Bu

Logic and Bit Operations W= CoctDu

Lookup Tables
Math Operakions
MrModel Yerification
FModel-YWide Ltilitie=s
Porks 2 Subsystems
Signal akkribub=s
Signal Fouting
Sinks

Saurces

State-Space

Transzfer Fon

Tranzport Delay

2| |-

wariable Transport Delay

£=12
FE+1)

Zero-Fole

User-Defined Functions
Additional Makh 2 Discrete
erospace Blockse:

DML R eference Blockset

¥ [ R

TE
€

R
k"

Readsw
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Block Diagram Construction

Basically, one has to specify the model of the system (state
space, discrete, transfer functions, nonlinear ODE's, etc), the
Input (source) to the system, and where the output (sink) of
the simulation of the system will go.

Open up the Sources, Sinks, and Linear windows by clicking on
the appropriate icons.

o Note the different types of sources (step function, sinusoidal,
white noise, etc.), sinks (scope, file, workspace), and linear
systems (transfer function, state space model,
etc.).

The next step is to connect these icons together by drawing lines
connecting the icons using the left-most mouse button (hold the
button down and drag the mouse to draw a line).
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Sources

1 simulink Library Browser

— Sources library

() 22|42 Find ||

R contains the sources
of data signals to be
= e - used in the dynamic

#+| Continuous

B v = oo system simulation.

o s E.g. Constant signal,

e 1] rassinnos sighal generator,

51 s roues /] e sinusoidal waves, step
o B Fce it hcie sequences like pulse

F2| gipl

R andorm Murmber

+- M| Fuzzy Logic Toolbox el Signal Generator
+- Wl Meural Mebwork Blockset - d

B real-Time Windows Target E Siait | Sigral Build tral nS a,n ram pS etC "
+- B Real-Time Workshop =

+- B S-function demos
+ EJ SimPowerSystems
+- B simulink Extras

Sine W ave

I
¥
J_ Step
I
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Sink

File Edit Wiew Help

O = A find ||
Digplay: .’Iumeric dizplay of input walues.

=I- i@ simulink
2 Continuous
2| Discontinuities
¥z Discrete
#| Look-Up Tables
H| Math Operations
2| Model Verification
B Model-wide Utilities
¥ Ports & Subsystems
] Signal Attributes
#+ Signal Routing

3 Sinks >

2 User-Defined Functions
B Cortrol System Toolbox
+- W] Fixed-Point Blocksst
+- B8 Fuzzy Logic Toolbox
+- W@ Meural Metwork Blockset
B Real-Time Windows Target

+- BB Real-Time Workshop
+- B S-function demos

+- BB SimPowerSystems
+- W@ Simulink Extras

9/18/2006

| 1z =l
| a
|§| Floating Scope

Dutt

@ Scoope
Stop Sirulation

Terrmninator

untitied. mat| To File

zsimout | To'Wwoaorkspace

v Graph

Sinks library contains
blocks where the
signal terminates.

You may store data in
a file, display it.
Use the terminator

block to terminate
unused signals.

STOP block is used
to stop the simulation
If the input to the
block is non-zero.

ELG3311: Electric Machines and Power Systems 40



‘ An Example

<) Scope M=l E3

lemlopre ABEB B L &

Vi »]
Sine Wae
Soope
r
=
Integm=mtor
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Building this Model: Creating an Empty Model

= click the New Model button on the L|brary Browsers

tOOlbaI‘ [T simulink Library Brows

File Edit Miew Help

=101 %]

New model button —PO = o h

Commonly Used Blocks: simulink/Commanly
Uzed Blocks

=2 EJ Simulirik.
: o B2 Comman Iy Used Blocks

= Simulink opens a new model Wlndow

FI|E Edit Wiew Simulation Formak  Tools  Help

SN [ Commonly Used Blocks

=10 x|

D|E-"E§|J$E|S'Q|b llNu:urmaI v”@%‘:

Ready [100% |ode4s
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Building this Model: Adding Blocks

To create this model, you need to copy blocks into

the model from the following Simulink block libraries:

o Sources library (the Sine Wave block)

o Sinks library (the Scope block)

o Continuous library (the Integrator block)
o Signal & System library (the Mux block)

A

i } -
Sine Waye 1

— | Soope

9/18/2006 ELG3311: Electric Machines and Power Systems
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Building this Model: Connecting the Blocks

First, position the pointer on the line between the Sine Wave and the
Mux block.

Press and hold down the Ctrl key (or click the right mouse button).
Press the mouse button, then drag the pointer to the Integrator
block's input port or over the Integrator block itself.

Release the mouse button. Simulink draws a line between the
starting point and the Integrator block's input port.

Finish making block connections.

A
| W | -
Sine Wawe
: Soope
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Building this Model: Configuring the Model

= Now set up Simulink to run the simulation for 10
seconds. (Simulation Parameters)

Stop time parameter

&4, Configuration Parameters: untitled/Configuration {Active) ﬂ

— Simulation tirme: Y =

Start time: (0.0 Stop time: I'I nao

- Data Import/E xport
- [ phimization
[#- Diagnostics

- Hardware Implementation | Tupe: I'\-’ariable-step vl Salver: | ode45 [Dormnand-Prince)

—Solver options

- Model Referencing . .

. bl ax step size: Iauto Relative tolerance: |1e-3
[+~ Real-Time YWorkzhop & I
#-HOL Coder Min step size: Iauto Abszolute tolerance:lauto
Initial step size: Iauto
ZE0 crossing u:ontrnl:l |Jze local settings vl

[~ Automatically handle data tansfers bebween tasks

—Solver diagnostic controls

Murnber of consecutive min step size vialations allowed: I‘l |

Consecutive zero crossings relative tolerance: I‘l 01 28%eps

Murber of consecutive zero crozsings allowed: I‘l non

4| | _’|;I
(] I Cancel | Help | Apply |
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Building this Model: Running the Model

Now double-click the Scope block to open its display
window.

Finally, choose Start from the Simulation menu and watch the
simulation output on the Scope.

leB(locre ABR B E &

Time affzet: 0
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Reference: See the help of SIMUIINK
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Good Luckl!l/
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